# CONTENTS

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Introduction</strong></td>
<td>3</td>
</tr>
<tr>
<td>Introduction</td>
<td>4</td>
</tr>
<tr>
<td>Vision and Approach</td>
<td>6</td>
</tr>
<tr>
<td><strong>Our solution to a social problem</strong></td>
<td>7</td>
</tr>
<tr>
<td>A Social Problem</td>
<td>8</td>
</tr>
<tr>
<td>Our Solution</td>
<td>9</td>
</tr>
<tr>
<td><strong>Sources, activities and results in the monitored period</strong></td>
<td>13</td>
</tr>
<tr>
<td>Resources Used</td>
<td>14</td>
</tr>
<tr>
<td>Activities Carried Out</td>
<td>15</td>
</tr>
<tr>
<td>Results and Impact</td>
<td>19</td>
</tr>
<tr>
<td>Quality Monitoring</td>
<td>22</td>
</tr>
<tr>
<td>Year-on-Year Comparison</td>
<td>23</td>
</tr>
<tr>
<td><strong>Planning and future development</strong></td>
<td>24</td>
</tr>
<tr>
<td>Planning and Goals</td>
<td>25</td>
</tr>
<tr>
<td><strong>Organizational structure and the team</strong></td>
<td>26</td>
</tr>
<tr>
<td>Organizational Structure</td>
<td>27</td>
</tr>
<tr>
<td>Meet the Team</td>
<td>28</td>
</tr>
<tr>
<td>Cooperation with Other Organizations</td>
<td>30</td>
</tr>
<tr>
<td><strong>About the organization</strong></td>
<td>34</td>
</tr>
<tr>
<td>Basic Information</td>
<td>35</td>
</tr>
<tr>
<td>Organization Management</td>
<td>36</td>
</tr>
<tr>
<td>Ownership Structure, Membership and Forms of Close Cooperation</td>
<td>38</td>
</tr>
<tr>
<td>Social and Environmental Profile of the Organization</td>
<td>40</td>
</tr>
<tr>
<td><strong>Finance and accounting</strong></td>
<td>42</td>
</tr>
<tr>
<td>Account Keeping</td>
<td>43</td>
</tr>
<tr>
<td>Impact of the COVID-19 pandemic on the organization's finances</td>
<td>44</td>
</tr>
<tr>
<td>Balance Sheet</td>
<td>45</td>
</tr>
<tr>
<td>Profit and Loss Report</td>
<td>46</td>
</tr>
<tr>
<td>Plan for Future Economic Management</td>
<td>48</td>
</tr>
</tbody>
</table>
INTRODUCTION
After 2019, we wished for **stability, sustainable growth, new branches** and newly opened educational centers bursting at the seams. We put our trust in the benefits of in-person learning, such as interaction, group strength, safety and clarity.

And then **March came**. The month, during which we worked non-stop, starting up new Digital Academies and long-term courses. We had to close our classrooms and cancel over 130 planned events, meetups and hackathons. We lost significant income and reduced our expenses. **It was a time of massive uncertainty and we had to work even harder.** In spite of all the obstacles, however, we felt that thanks to the amazing community that we are surrounded by, this year would be our best yet. A year, when only a few hours after lockdown, **we pulled an ace from our “Nice to Have” sleeve called “Online Learning”** and were able to react to the opportunity presented: to change the educational design and make it of equal quality and just as interactive as in-person learning. A year, which showed that together we can work with changes presented to us, that we’re creative and have solidarity. A year when we were able to reach even more households thanks to online learning thereby increasing our social impact.

We **popularized digital literacy and technical and lifelong education at online conferences**, even at the European Parliament, using new **online tutorials**, the traditional Czechitas Award and the EU Code Week, Hour of Code and the Charger campaigns. We contributed to formal education by co-organizing the **#DIGIEDUHACK hackathon** under the auspice of the Ministry of Education, Youth and Sports with the goal of creating a platform for teachers to share their experiences.

We taught children and adults, mainly women and mostly online, the basics of programming, testing, data analysis and web creation. Thousands of women. From four-hour workshops through week-long and semester courses to intensive academies. Thanks to the Digital Academies, we let out **217 new female data analysts, web developers** and this time also **testers** into the world. We have successfully piloted the Academy of Testing, a private Academy for a company and now even as an all-state version for more advanced participants – Academy: Project.
We want for women equipped with new skills to obtain new work in IT, to start their own projects or to improve or learn such skills, which will help them in their jobs as well as their personal lives. We also focus on the employability of our female students. We support women from the Academies so that their projects become live organizations and we **connect our female graduates with potential employers**. We also piloted a mentoring platform on our career portal [On Work in IT](#) and we also provide individual career counselling.

**The Community** is the fundamental basis for Czechitas. It connects everyone in one place. Thanks to the support, trust and flexibility of our general partners, we’re able to make the dreams of the women we teach, as well as our own dreams, come true. Thanks to CTP Invest, we welcomed over 11,000 visitors at our educational center na Ponávce since September 2019 in spite of the closed doors during the pandemic. Thanks to Accenture, we opened Czechitas Home in Prague in February. Together with the employees of Microsoft, we delved into preparing certified Microsoft Fundamentals courses. A huge thanks also goes to Google.org for their financial help during the first wave of the pandemic, which was used to move our courses online and for creating new webinars. And for the trust that they have given us for the **third time** already!

A big thank you also goes to the hundreds of partners who have been participating in educating and employing new IT talents especially to our strategic partners: Avast Software, Barclays, BOSCH, Honeywell, Nestlé Česko, Oracle Czech, SAP ČR, ŠKODA AUTO, T-Mobile Czech Republic, Thermo Fisher Scientific Brno and Verizon Czech. The Board of Directors, 518 instructors, workshop leaders, coaches and mentors, now already 51 employees in 8 cities, headed by Ondřej Čejka, who took over the leadership reins as Chief Operating Officer in September, send their thanks for their huge commitment, cooperation, humility, their approach to change, their big hearts, their playfulness, the meaning they give to every story. And so, with great confidence in the Czechitas leadership, I was able to move into a strategic and culture- and brand-caring role.

We have a big year ahead of us once again. **We will get 30,000 people interested in technology in 2021, improving their digital and IT skills while contributing to the diversity and innovation of Czechia.** Our commitment is to offer a safe space for education. Education that is relevant and also available to mothers on maternity leave, those who are unemployed, living away from large cities and those older than 45.

I cannot wait.

_Dita Formánková_  
Founder & Non-Executive Director
**Mission**

Our mission is to inspire, motivate and educate new talents in order to strengthen diversity and the competitive edge in IT. We create a community connecting people who want to learn or teach IT. We connect private companies, state administration and local self-government, academia and schools, experts from the community, other projects and non-profit initiatives and people who are learning and looking for work all in one place. We want to become a partner of lifelong learning.

Our vision is to become the decisive and most relevant institution for informal education for professions of the future in Czechia by 2022. We strive to increase the number of talents in technical professions and to improve IT and digital proficiency of groups not represented adequately in this segment at the moment as well as those threatened by digitalization. We think socially. We show that technologies are not only needed for the future on the job market but they are an everyday necessity. We show that IT can be interesting for boys, girls, men and women.

**Vision**

We will build regional innovative educational centers and an online platform to support popularization, education, employability and community development.

100,000 new talents will increase their interest in technology and their digital literacy.

Most of them will apply their new skills even further by applying to a technical university, by getting new work, improving their current profession or starting their own project.

**Approach**

Our activities stand on four pillars: on the popularization of technical education, on education itself, on employing new talents and on building a community in IT. We organize lectures, discussion groups, educational campaigns, one-day and long-term courses, tech meetups, intensive academies, day camps, job fairs, career counselling and community events and provide mentoring for children, women, teachers, parents and companies.
OUR SOLUTION TO A SOCIAL PROBLEM
A SOCIAL PROBLEM

A Lack of Qualified ICT Employees

Technologies are changing the world around us. There are several studies that predict how many jobs will become extinct due to automation and robotization. We don’t know what the actual number will turn out to be. But it is clear that the nature of the work will change as will the demands for skills, which we’ll need to perform certain jobs. And these changes are already becoming apparent. According to Eurostat, Czechia is a country, where employers are having the hardest time finding new talents in IT. There are thousands of people missing on the job market and 80% of Czech companies have a problem finding qualified ICT employees.¹

Low Representation of Women on the Job Market with a Focus on Positions in IT

Men comprise 90% of all employees in the ICT segment. The COVID-19 pandemic highlighted even more the need for women on the job market.² That is why it is necessary to improve their qualifications in digital and technical skills in order to help them be more successful on the job market and have a competitive edge in terms of having equal access to employment opportunities.³

Current Changes on the Job Market in Relation to COVID-19

The pandemic measures implemented not only in Czechia but all over the world accelerated the need to operate in the digital environment. They forced many individuals and companies to quickly get accustomed to digital processes and new methods of work and communication. Long-distance collaboration will continue to play an important role in many companies across various fields. The COVID-19 economic recovery data also indicates that it is precisely professions related to technology, which will remain most valuable and most in demand on the job market.⁴

Deficiencies in Teaching Informatics at Schools and Inadequate Readiness of Teachers for Using Digital Technologies in Teaching

A problem that had been talked about for a while only got bigger in 2020. The school curriculum lacks sufficient space for quality teaching of informatics and using digital technologies, as well as the use of digital technologies in teaching itself. Informatics education is currently not able to react quickly enough to the dynamic changes in technologies and on the job market.

Obstacles in Standard In-person Learning

The pandemic denied access to standard in-person learning to many students. Thanks to online courses, we therefore have a new opportunity to get education into locations, where in-person learning in IT fields was not standard.

---

¹ Johnston, R. (2020). Czech firms have the second-hardest time in the EU filling ICT positions
² Czech Statistical Office (2019)
⁴ Sedlák, J. (2020). Firmy propouští, ruší projekty a přestaly nabírat. Jaký má koronavirus dopad na IT trh v ČR?
**OUR SOLUTION**

**OUR ACTIVITIES**

Czechitas activities, responding to the social problems listed above, stand on the following pillars:

1. **Popularization** of lifelong and technical education
2. **Education** in technical skills such as programming, coding, data analysis, testing and digital skills
3. Mentoring and **supporting** graduates as they enter the job market
4. **Building a community** of IT experts and volunteers who want to teach with us and participate at our events, as well as the active participation of partner companies with the goal of improving the situation on employing women on the job market.
**FIRST PILLAR**

**Popularization activities include the following:**

» Popularization articles
» Czechitas Thesis Award (for the best female IT bachelor's thesis)
» Popularization campaigns
» Presentations at development, teaching and other thematic conferences and festivals.

**SECOND PILLAR**

**Educational activities include the following:**

» One-day courses
» Long-term evening courses
» Intensive week-long courses
» Three-month intensive Digital Academy course: Data, Web and Testing
» IT Summer School for secondary school students
» After-school clubs and day camps for children 8 to 12 years old
» Hackathons
» Advanced meetups
» Online courses for self-study
» Workshops for teachers
» Webinars
» Methodology for IT education.

**THIRD PILLAR**

**Mentoring and supporting graduates as they enter the job market includes the following:**

» Career coaching and counselling
» Connecting students with employers through internships and other forms of employment
» Organizing the Czechitas Job Fair.

**FOURTH PILLAR**

**Building a community of IT experts and volunteers includes the following:**

» Regular meetings between company partners, instructors and volunteers
» Educating partner companies, which increase diversity at the workplace, e.g. Honeywell Diversity Project Pilot, discussions on job market trends, sharing best practices
» Training IT experts in lecturing skills.
Our Target Groups

**Women**
Czechitas calls upon women regardless of age, education and job position to not be afraid of IT and to explore the opportunities this world offers. We teach them the basics as well as more advanced skills in a safe environment and help them get work in IT.

**Children and Adolescents**
Czechitas applies enjoyable and playful techniques to introduce children and adolescents to the basics of programming, robotics and IT security. We provide them with the basis for future study of informatics and deepen their interest in IT. We get children, adolescents and their teachers involved in the global Hour of Code event.

**The Public**
Czechitas is popularizing the topic of lifelong learning and specifically IT education. We understand that education in IT and digital skills are needed not only for work but everyday life and obtaining new opportunities. We believe that digital skills help people create a future of their choice.

**Employers**
Czechitas inspire employers to change their ways of thinking and build diverse teams. We collaborate with partners who are looking for new talent and want diversity. We share with them our know-how on how to show women the benefits of IT jobs.
EXPECTED RESULT AND IMPACT ON DIRECT AND INDIRECT TARGET GROUPS

**The Public:**
» Better IT and digital literacy in society  
» Motivation for parents to support their children to study IT fields

**Women:**
» Motivation and self-confidence for women to enter the IT job market  
» Career advancement of women to more attractive or IT positions  
» Creation of their own projects

**Children and Adolescents:**
» Motivating children and adolescents to be interested in technology or to study a technical field

**Employers:**
» Diversity in teams and strengthening those teams with new talents in IT companies  
» Interest of IT experts to share their knowledge and experience
SOURCES, ACTIVITIES AND RESULTS IN THE MONITORED PERIOD
RESOURCES USED

We were able to organize our activities thanks to the financial and non-financial resources as well as barter collaborations with companies as well as individuals. Partnerships most often include financial support, loaning us a space to hold lecturers as well as the knowhow of employees.

**Individual resources:**

- **Financial:** Entry fees from events, donations, sponsoring, subsidies and grants
- **Time:** Lecturing, coaching and volunteering
- **Material:** Offices, technical equipment and furniture
- **Intangible:** Know-how on running an organization, know-how of the instructors, knowledge and skills of internal employees
The main goal for 2020 was to actively get the same number of people involved in our activities as in 2019, i.e. 10,000 people. Our activities were aimed at popularization, education and employability in IT.

Due to the pandemic and related governmental restrictions, we were forced to move our activities online. The first transition took place on 11 March, where our Digital Academies and long-term courses moved online and the second, for the one-day courses, came in April. The governmental restrictions were lifted during the summer but as of 5 October, we were once again running completely online.

We organized a total of 371 events.

**Employability: 2**
- Czechitas Thesis Award
- Online programming hackathon

**Popularization: 21**
- Code Week, Czechitas Talks, Hour of Code, Get to Know Czechitas

**Community: 62**
- 9 Tech Meetups
- 7 Work with Czechitas
- 46 trainings and workshops at FabLab

**Education: 286**
- 217 one-day courses for adults
- 10 one-day courses for children
- 5 children’s day camps
- 4 IT Summer School for female secondary school students
- 4 intensive week-long courses
- 32 semester courses (90-100% carried out online)
- 11 Digital Academies (90% carried out online)
- 3 after-school clubs for children (90-100% carried out online)
POPULARIZATION ACTIVITIES

» Presentations at 18 development, teaching and other thematic conferences and panel discussions
» Live Facebook session on the topic of Internet safety, where we reached more than 3400 people
» Campaign during the country-wide quarantine – “Program Your Own Game” – that had more than 23 000 online views
» DigiEduHack, a hackathon in collaboration with DigiKoalice and the Ministry of Education, Youth and Sports that had 44 participants and mentors
» Hour of Code campaign, where a total of 406 children and 23 adults took part in the coding
» Christmas Codemas campaign, with the goal of increasing the public’s interest in IT and to bring HTML and CSS to more people, had more than 4000 online views
» Get to Know Czechitas, online lectures, which helped a total of 330 participants find a suitable Czechitas course
» Get to Know Digital Academy, online lectures for 318 women interested in Digital Academy
» Czechitas Thesis Award, a competition for the best female bachelor’s thesis on a topic related to IT
» EU CodeWeek with a program for elementary school students
» Digi recommendations and webinars on the topic of Family Communication with T-Mobile
» Czechitas Book creation
» 334 mentions in the media
» Partnership with the Drbna media portal
EDUCATIONAL ACTIVITIES:

We organized a total of **286 educational events**.

<table>
<thead>
<tr>
<th>Number of events</th>
<th>Adults</th>
<th>Children and Adolescents</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-day courses</td>
<td>217</td>
<td>10</td>
</tr>
<tr>
<td>Week-long courses</td>
<td>4</td>
<td>9</td>
</tr>
<tr>
<td>Semester courses</td>
<td>32</td>
<td>3</td>
</tr>
<tr>
<td>Digital Academies</td>
<td>11</td>
<td>-</td>
</tr>
</tbody>
</table>

We published a new online video tutorial on the Introduction to Java self-study free of charge for the general public in April.
We have extended our courses to include the following:

» Digital Skills Series
» React Course
» Become a Coder Course
» How to Teach Online Using Zoom
» How to Internet
» Inside the Computer
» Introduction to Algorithms
» Python for Data
» Digital Academy: Testing
» Digital Academy: Project
» Internet of Things with Hardwario
» Microsoft Azure Fundamentals

Digital Academy

A total of 11 Digital Academies:

» Digital Academy: Data in Brno and Prague
» Digital Academy: Web in Brno and Prague
» Digital Academy: Testing in Brno, České Budějovice and Ostrava
» Digital Academy: Online Project

New Generation Czechitas

» Activities were limited to a minimum in the first half of the year
» 5 children's day camps
» 4 IT Summer School for female secondary school students, for the first time in Liberec
» Online robotics courses at two elementary school in collaboration with LEGO
» First online after-school club in Scratch

Employability

» A pilot mentoring platform on a career portal
» Courses aimed at career development
» Individual career counselling for Digital Academy graduates: Testing

Additional Activities

» Running, implementation and additional expansion of the Czechitas Community portal
» Innovation in the internal information system and the My Czechitas portal
» Setting a career path for our instructors
» Collecting know-how on How to Teach Online and shooting videos and implementing them in the instruction
» Analysis of the informal education market, IT and products
» Creation of a Pandemic Plan
RESULTS AND IMPACT

We reached our goal of getting 10,000 people involved through our activities. A total of 13,518 people took part in our activities.

» 1,325 participants in popularization activities
» 27 participants supporting employability
» 403 participants at community events
» 8,011 graduates of educational activities
» 3,752 potential participants at our self-study online tutorials

Age of participants:
EDUCATIONAL EVENTS:

A total **8,011** graduates.

<table>
<thead>
<tr>
<th>Number of events</th>
<th>Adults</th>
<th>Children and Adolescents</th>
</tr>
</thead>
<tbody>
<tr>
<td>One-day courses</td>
<td>6,528</td>
<td>181</td>
</tr>
<tr>
<td>Week-long courses</td>
<td>107</td>
<td>219</td>
</tr>
<tr>
<td>Semester courses</td>
<td>624</td>
<td>42</td>
</tr>
<tr>
<td>Digital Academies</td>
<td>310</td>
<td>-</td>
</tr>
</tbody>
</table>

[Online graduates: 4,404 (55%)]
[Offline graduates: 3,607 (45%)]

Number of graduates
ONLINE TUTORIALS

» Introduction to JavaScript (657 participants)
» Introduction to Java (499 participants)
» Introduction to HTML and CSS (1,662 participants)
» Introduction to Python (934 participants)

EMPLOYABILITY

» **81 women obtained work thanks to our direct connections.** The following are the most frequently filled positions: Data/BI Analyst, Web Developer, Tester, Consultant and Software Developer.

» 251 of our 772 Digital Academy graduates have already found new work. 93 graduates in Brno, 23 in Ostrava and 135 in Prague.
A data team was created as part of our organization in 2020, which is in charge of monitoring quality internally as well as externally. Internal monitoring includes events carried out, planning out capacities of the production team and setting up processes so that relevant data can be obtained from them. Externally, it monitors quality using questionnaires sent to course participants. About 60% of them make it back to us. More than 3/4 of our participants rate the organization of our courses, the instruction and the instructor team as perfect and would recommend our courses to friends.

We received feedback for our partner meetings in Prague and Brno from our partners using SWOT analysis. We then implemented the opportunities found. They included, e.g. adding courses focusing on soft skills (Presentation Skills and Effective Communication as part of the Digital Academies), scholarships for participants (in Digital Academy: Testing), hybrid models of education (online/offline), building long-term relationships with instructors (creating Paths for Instructors) or a new project incubator (Digital Academy: Project).

We improve our educational courses by monitoring trends on the IT market by participating at international and local conferences and via consultations with experts from the IT field, such as e.g. with doc. Ing. RNDr. Barbora Bühnová, Ph.D.

Apart from monitoring the quality of our courses, we also conducted a survey on employee satisfaction, which 78% of employees filled out. The survey showed a high level of engagement and identification across Czechitas and confirmed that meaningful work and the values of our organization are what is most important to our employees.
## Year-On-Year Comparison

<table>
<thead>
<tr>
<th>Goals Reached</th>
<th>2020</th>
<th>2019</th>
<th>2018</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of Educational Events</td>
<td>286</td>
<td>238</td>
<td>146</td>
</tr>
<tr>
<td>No. of graduates of our in-person and online educational events (4+ hours)</td>
<td>8,011</td>
<td>5,821</td>
<td>4,344</td>
</tr>
<tr>
<td>No. of women employed in IT thanks to our direct connections</td>
<td>81</td>
<td>96</td>
<td>113</td>
</tr>
</tbody>
</table>
Planning and future development
PLANNING AND GOALS

The ambitions of Czechitas remain the same – to build the largest platform for informal education in digital skills and help employ new talents in professions of the future in Czechia. The main target group will continue to be women, as a group most threatened by digitalization. We will strive to increase their digital and IT literacy, teach them programming, testing, coding and data analytics and help them to apply that knowledge in practice. We will continue to work with children in order to get them excited about technology and using it safely as well as lifelong learning.

Czechitas financing was stabilized with support of the Velux Foundation in Denmark, which is mainly an investment into the social impact of Czechitas activities. We obtained an opportunity to focus on quality and setting up the most effective assessment of the impact of Czechitas activities in the personal stories of our graduates as well as the overall social context of the impact on increasing digital literacy in Czechia. Support of the Velux foundation will also allow us to expand Czechitas activities into other regions of the country.

We plan on organizing 350 educational events for 10 000 students via live instruction in 2021. Apart from one-day and long-courses, we are preparing a Digital Academy focusing on web development, data and testing. In addition to Prague, the Digital Academy will also take place in Brno, České Budějovice and Ostrava as part of the continuation of the Czechitas Scholarship project supported by the European Union, as it did in 2020. In view of the COVID-19 situation, we plan to grow Czechitas preferably in the online environment, for which we have also developed new products such as the Digital Skills Series for Adults or the Digital Competence Series for Teachers, where we will introduce them to current technologies for teaching across primary/secondary school subjects.

We are expanding our online activities to include self-study modules - tutorials for basic digital skills. We plan to develop an e-learning platform to make digital literacy basics courses accessible. The courses will be aimed at everyone interested in self-education and will be available free of charge just like our current tutorials. We expect about 5000 students in 2021.

Together with the team, we will continue to build the structure of the organization for its sustainable development, automation of internal systems, creating data reports, unifying marketing communication, collaborating with state and regional institutions, developing new products, mentoring, working with talent and developing leadership skills, optimizing processes and building corporate culture.

“We plan on organizing 350 educational events for 10 000 students via live instruction in 2021.”
ORGANIZATIONAL STRUCTURE AND THE TEAM
Changes took place in the organization structure in the fall of 2020 and it currently looks like this:

Founder

Co-founding & Governing Board comprises four members who actively monitor the running of the organization and use their expert guidance and presentation at public events to further its development. They also guarantee that the Czechitas mission and vision is fulfilled, including maintaining the basic values.

Directors play an essential role in leading and managing the organization and include the following two positions:

» N-ED Non-Executive Director
» ED Executive Director

Central Departments cover the operations of the organization and delivery of top-quality services. They work in the following areas:

» Development
» Finance & Data
» HR & Shared Services
» Marketing
» Partnerships
» Product & Operations

Branches are represented by local teams at the various locations and ensure the delivery of services directly to the target groups:

» Brno
» České Budějovice
» Liberec
» Mladá Boleslav
» Olomouc
» Ostrava
» Prague
» Zlín

Wider Team comprises a community of instructors, coaches, photographers and workshop leaders who organize events directly on site or online as well as specialists that expand the expert basis for running the organization.
MEET THE TEAM

CO-FOUNDING & GOVERNING BOARD

Dita Formánková
Monika Ptáčníková
Miroslava Zatloukalová
Barbora Bühnová

DIRECTORS

Dita Formánková
N-ED

Ondřej Čejka
ED
HEADS

Ondřej Čejka, Head of Partnerships  
Hana Hřívová, Head of Regional Development  
Lucie Jurystová, Head of Development  
Olga Maximová, Head of HR & Shared Services  
Kateřina Reiglová, Head of Finance & Data  
Marek Sedlák, Head of Marketing  
Hana Vykydalová, Head of Product & Delivery

REGIONAL MANAGERS

Mária Falterová, Regional Coordinator Ostrava  
Jana Filipová, Regional Coordinator Olomouc  
Petra Holajová, Regional Coordinator Liberec & Mladá Boleslav  
Kateřina Kalačová, Regional Manager Brno  
Iva Kožíková, Regional Coordinator Zlín  
Žaneta Kubová Andělová, Regional Coordinator České Budějovice  
Pavla Verflová, Regional Manager Praha
COOPERATION WITH OTHER ORGANIZATIONS

GENERAL PARTNERS 2020

accenture  ctp  Evropská unie
Evropský sociální fond
Operační program Zaměstnanost

Google.org  Microsoft

THE VELUX FOUNDATIONS
VILLUM FONDEN  VELUX FONDEN
STRATEGIC PARTNERS 2020

AT&T  avast  BARCLAYS  BOSCH  ČESKÁ
ROZVOJOVÁ
AGENTURA  Honeywell

Nestlé  ORACLE  NETSUITE  SAP  ŠKODA  ThermoFisher
SCIENTIFIC  verizon

REGIONAL PARTNERS 2020

BRNO  go  IBM  MSD  RWS
Moravia

telegraph gallery  vision  YSOFT
COMPANIES AND ORGANIZATIONS WITH WHICH WE COLLABORATED IN 2020
ABOUT THE ORGANIZATION
**BASIC INFORMATION**

**ORGANIZATIONAL STRUCTURE**

<table>
<thead>
<tr>
<th>Name of Organization</th>
<th>Czechitas z.s.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Seat</td>
<td>Václavské náměstí 837/11, Nové Město 110 00 Praha 1¹</td>
</tr>
<tr>
<td>Organization Founded On</td>
<td>22. 8. 2014</td>
</tr>
<tr>
<td>Other Branches</td>
<td>Brno, České Budějovice, Liberec, Mladá Boleslav, Olomouc, Ostrava, Zlín</td>
</tr>
<tr>
<td>Legal form</td>
<td>zapsaný spolek</td>
</tr>
<tr>
<td>Contact Information</td>
<td><a href="czechitas.cz/cs/kontakt">czechitas.cz/cs/kontakt</a></td>
</tr>
<tr>
<td>Articles of Association</td>
<td>[Stanovy organizace](Stanovy organizace)</td>
</tr>
</tbody>
</table>

**EMPLOYEE STRUCTURE**

<table>
<thead>
<tr>
<th>No. of Employees</th>
<th>2020</th>
<th>2019</th>
</tr>
</thead>
<tbody>
<tr>
<td>No. of Employees</td>
<td>396</td>
<td>209</td>
</tr>
<tr>
<td>Of that on an employment contract</td>
<td>24</td>
<td>19</td>
</tr>
<tr>
<td>Of that on maternity/pa-</td>
<td>6</td>
<td>5</td>
</tr>
<tr>
<td>rental leave</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Of that under an agree-</td>
<td>314</td>
<td>185</td>
</tr>
<tr>
<td>ment to perform work</td>
<td></td>
<td></td>
</tr>
<tr>
<td>No. of volunteers</td>
<td>73</td>
<td>43</td>
</tr>
<tr>
<td>No. of external staff</td>
<td>557</td>
<td>406</td>
</tr>
</tbody>
</table>

As of 31 December, 2020, we have 396 co-workers under an employment contract or under agreements to perform work at various capacities, which is an 89% increase from 2019.

Most of our internal colleagues have flexible working hours and can work from home at their own discretion. We allow for and support part time work for women on maternity leave or parental leave.

Our new employee numbers grew by 37 % in 2020. Most of those include consultants, instructors, coaches, organizers and photographers.

---

¹ The organization changed its seat on 30 December, 2020.
The highest executive body of the Czechitas organization is the General Meeting, which meets at least once a year and elects the individual executive body – the organization’s Chair. Competencies of the General Meeting include: presentation of proposals, comments and suggestions on the organization’s activities, actively defend the interests of the organization, assess and approve reports on the organization’s activities.

Members of the General Meeting as of 31 December, 2020 are:

» Barbora Bühnová
» Dita Formánková
» Monika Ptáčníková
» Miroslava Zatloukalová

The executive (statutory) body is the Chair of the board. The Chair is elected by the General Meeting. The term of office is 5 years. The Chair has the following competencies: acts on behalf of the organization, makes decisions on issues related to the way the organization works, disposes of its assets, hires employees, terminates the employment of members and employees of the organization, makes decisions on all other employment matters, convenes the General Meeting, maintains the proper agenda of the General Meeting and the list of members of the organization.

Chair of the Organization as of 31 December, 2020:

» Dita Formánková
SUPervision

The organization did not establish a control commission or another supervisory body.

CONFLICT OF INTEREST

No member of the organization nor its Chair are in conflict of interest with the line of business of the organization.

An internal directive regulating the conflict of interest of Czechitas employees with the interest of the employer came into effect in 2020.

INTERNAL CHECK SYSTEM

The organization has several internal check systems in place:

» The Chair’s term in office is limited to 5 years
» The General Meeting must take place at least once a year
» The option to expel a member of the organization by the Chair
» Approving decisions through a majority vote of a General Meeting quorum
» Obligation of the Chair to present a strategic plan for the organization to the General Meeting once every 3 years
OWNERSHIP STRUCTURE

The Chair is the beneficial owner of the organization according to Act no. 253/2008 Coll., on certain provisions to prevent legalization of profits from illegal activity. The Chair of the organization is officially entered as the beneficial owner in the beneficial owner register.

CONNECTED PERSONS AND FORMS OF CLOSE COOPERATION

No connected persons and no forms of close cooperation.

MEMBERSHIP IN OTHER ORGANIZATIONS

None.
As of 1 January, 2020, a merger with the IT Education Association z.s., Co. Reg. No. 22815091, seat: Na Mlejnku 764/18, 147 00 Prague 4 (hereinafter referred to as “IT Education Association”), took place according to Sec. 178(2) of Act No. 89/2012 Coll. of the Civil Code, as amended (hereinafter referred to as “Civil Code”). All the rights and obligations of the IT Education Association were transferred to Czechitas as part of the merger.

This merger took place in relation to Czechitas’ plan for change of its legal form from an association as per Sec. 214 of the Civil Code to an institute as per Sec. 402 of the Civil Code. Czechitas plans to make this transition in part also because the legal form of an institute currently much better suits the needs and internal structure of Czechitas as a non-profit organization, whose main goal is to provide and promote education especially in information technology. Czechitas opted for the merger with this association partly due to the fact that the two associations have similar programs and also because of the possibility to transfer to Czechitas the right of IT Education Association to change its legal form to an institute according to Sec. 3045(1) of the Civil Code. The potential for the transfer of this right based on the merger was also confirmed by several legal interpretations, which Czechitas had at its disposal.

Once the merger project was carried out, several notaries refused to change Czechitas’ legal form to an institute since they were not convinced that the right according to Sec. 3045(1) of the Civil Code was a right that could be transferred from an association being dissolved to the successor association as part of a merger. According to the interpretation of the notaries, the Civil Code presupposes that on the contrary, this right is bound only to the specific association and ceases to exist together with the association. The notaries contacted therefore refused to carry out the planned transformation and Czechitas transition to an institute did not occur in 2020.

Czechitas is planning to take additional legal steps in 2021 in order to carry out the transformation of its legal form to an institute.
SOCIAL AND ENVIRONMENTAL PROFILE OF THE ORGANIZATION

SOCIAL ASPECT

We support IT education

We use our activities to help women increase their qualification to be able to better compete on the job market and in their personal lives. This allows us to influence one of the goals for sustainable development – top-quality education.

We support equal opportunity

Supporting equal opportunity as goal no. 5 for sustainable development and diversity in IT as well as inside the organization is paramount for us. As part of our educational activities, we primarily focus on women as a group, which is disadvantaged in the world of IT in Czechia. Popularization activities carried out online and activities for children are made available for women and men as well as girls and boys. We also promote the sense of diversity and inclusion beyond the realms of our organization. One such example is the Diversity and Inclusion Project at Honeywell, which we introduced this year.

We apply principles of equal opportunity between women and men on our teams e.g. as part of equal approach and opportunities for career advancement. We were able to strengthen our team in 2020 and we now have 442 women and 310 men working for us.

We are an attractive employer

We value and care for human capital at Czechitas. The employee survey conducted in 2020 showed that our employees most value the atmosphere in our organization, the good work-life balance it offers, flexible working hours and a genuine interest of the employees. All the employees support our vision and claim that they always speak about Czechitas in a positive manner. We are aware and respect our cultural values: meaningfulness, sustainability, playfulness, learning and collaboration.

During the pandemic, we emphasized netiquette and adherence to our internal rules for online communication both inside and outside the team. We organized two big events to support team work, summer online teambuilding, where we also invited our community, as well as our Christmas party.

We take care of the psychological well-being of our team. We organize internal online educational events on mental resilience. In June, we also organized a company-wide retrospective after the first wave of the corona crisis.
We support the growth of our employees and their potential to cooperate on various projects even beyond their standard scope of work. There is of course also the opportunity to learn for free at our courses, a personal allowance for external training and several hours per month dedicated to training for each employee. Employees may take advantage of mentoring from experts in IT, leadership, education etc.

Community
Our mission is to create a community, which supports education in IT, mostly of women, children, adolescents and teachers, and to make the world of IT more accessible to everyone with an interest in digital literacy. We support this community online as well as on a personal level. We organize meetings with company partners, graduates of our workshops, internal employees and external teams (instructors, coaches and workshop leaders). We actively support our course graduates to bring their newly acquired skills back to the community e.g. by becoming instructors or coaches themselves.

Environmental Issues

Waste
At Czechitas, we try to minimize the negative impact our activities have on the environment. We reduce waste, recycle, we use reusable packaging, minimize pollution and save energy. We limit printing, including contracts and other documents, which we sign electronically, to further protect the environment. We use electronic backup.

Awards
» Award of the Governor of South Bohemia
» Dita Formánková’s nomination among the 100 most influential women in Czechia
» Nomination for the “EQUALS in Tech Awards”
FINANCE AND ACCOUNTING

Czechitas managed its accounting and tax obligations through 22HLAV s. r. o., using the ABRA Flexibee accounting software. Accounting documents are archived electronically on the accounting company’s server and on paper at the offices of the organization at the following address: Václavské náměstí 837/11, 110 00 Prague 1.
There were concerns at the start of the pandemic as to how the situation would affect our operations and the future of our organization. We implemented several measures with the goal of reducing costs. We also took advantage of some government support programs. We handled the financial situation well thanks to our employees, co-workers, partners and donors. The pandemic therefore only had a minimal negative impact on the organization’s finances.
### Assets

_As of 31 December, 2020 (in thousands of CZK)_

<table>
<thead>
<tr>
<th>Description</th>
<th>Balance as of the first day of the accounting period</th>
<th>Balance as of the last day of the accounting period</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Total long-term assets</td>
<td>16</td>
<td>0</td>
</tr>
<tr>
<td>I. Total long-term non-tangible assets</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>II. Total long-term tangible assets</td>
<td>197</td>
<td>197</td>
</tr>
<tr>
<td>III. Total long-term financial assets</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>IV. Total adjustments to long-term assets</td>
<td>-181</td>
<td>-197</td>
</tr>
<tr>
<td>B. Total short-term assets</td>
<td>10,027</td>
<td>11,715</td>
</tr>
<tr>
<td>I. Total inventory</td>
<td>14</td>
<td>20</td>
</tr>
<tr>
<td>II. Total receivables</td>
<td>5,705</td>
<td>2,492</td>
</tr>
<tr>
<td>III. Total short-term financial assets</td>
<td>1,729</td>
<td>5,947</td>
</tr>
<tr>
<td>IV. Total other assets</td>
<td>2,579</td>
<td>3,256</td>
</tr>
<tr>
<td><strong>Total assets</strong></td>
<td><strong>10,043</strong></td>
<td><strong>11,715</strong></td>
</tr>
</tbody>
</table>

### Liabilities

_As of 31 December, 2020 (in thousands of CZK)_

<table>
<thead>
<tr>
<th>Description</th>
<th>Balance as of the first day of the accounting period</th>
<th>Balance as of the last day of the accounting period</th>
</tr>
</thead>
<tbody>
<tr>
<td>A. Total local resources</td>
<td>-1,327</td>
<td>3,107</td>
</tr>
<tr>
<td>I. Total capital</td>
<td>0</td>
<td>3,693</td>
</tr>
<tr>
<td>II. Total profit/loss</td>
<td>-1,327</td>
<td>-586</td>
</tr>
<tr>
<td>B. Total outside resources</td>
<td>11,370</td>
<td>8,608</td>
</tr>
<tr>
<td>I. Total reserves</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>II. Total long-term payables</td>
<td>0</td>
<td>1,369</td>
</tr>
<tr>
<td>III. Total short-term payables</td>
<td>9,091</td>
<td>5,155</td>
</tr>
<tr>
<td>IV. Total other liabilities</td>
<td>2,279</td>
<td>2,084</td>
</tr>
<tr>
<td><strong>Total liabilities</strong></td>
<td><strong>10,043</strong></td>
<td><strong>11,715</strong></td>
</tr>
</tbody>
</table>
## Profit and Loss Report

As of 31 December, 2020 (in thousands of CZK)

<table>
<thead>
<tr>
<th>A. Costs</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

| I. Purchases consumed and purchased services | 26,317 | 1,764 | 28,081 |
| II. Changes to inventory status of own activities and activation | 0 | 0 | 0 |
| III. Personal costs | 10,812 | 1,160 | 11,972 |
| IV. Taxes and fees | 2 | 0 | 2 |
| V. Other expenses | 422 | 31 | 453 |
| VI. Write-offs, assets sold, creation and use of reserves and adjustments | 17 | 0 | 17 |
| VII. Contributions provided | 0 | 0 | 0 |
| VIII. Income tax | 28 | 87 | 115 |

| Total costs | 37,598 | 3,042 | 40,640 |

<table>
<thead>
<tr>
<th>B. Revenue</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>x</td>
<td>x</td>
<td>x</td>
</tr>
</tbody>
</table>

| I. Operating subsidies | 3,623 | 0 | 3,623 |
| II. Contributions received | 22,414 | 0 | 22,414 |
| III. Proceeds for own performance and goods | 11,508 | 3,591 | 15,099 |
| IV. Other revenue | 245 | 0 | 245 |
| V. Proceeds from assets sold | 0 | 0 | 0 |

| Total revenue | 37,790 | 3,591 | 41,381 |

| C. Total profit/loss before taxes | 220 | 636 | 856 |
| D. Total profit/loss after taxes | 192 | 549 | 741 |
Revenue and Cost Structure

Revenue:
- Operating subsidies (8.8%)
- Contributions received (54.2%)
- Proceeds for own performance and goods (36.5%)
- Other revenue (0.6%)

Cost:
- Purchases consumed and purchased services (69.1%)
- Other expenses (1.2%)
- Personal costs (29.5%)
- Income tax (0.3%)
We are planning a surplus budget for 2021 with an increase in revenue of approximately 36% compared to 2020, mainly due to the expansion to other cities in the Czech Republic, an increase in course capacity in Prague and Brno and increased support from corporate partners and donors.

However, there is still a degree of uncertainty with regard to the COVID-19 pandemic and how it will affect support from our partners and donors. We are unable to quantify this level of uncertainty. We have therefore set up the budget in such a way so as to be able to ensure ongoing and sustainable operations of the organization even in the event the pandemic takes a negative turn.